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Legal Information 
©  Hangzhou Hikrobot Co., Ltd. All rights reserved. 

About this Document 

This Document includes instructions for using and managing the Product. Pictures, charts, 
images and all other information hereinafter are for description and explanation only. The 
information contained in the Document is subject to change, without notice, due to firmware 
updates or other reasons. Please find the latest version in the company website 
(https://en.hikrobotics.com/). Unless otherwise agreed, Hangzhou Hikrobot Co., Ltd. or its 
affiliates (hereinafter referred to as “Hikrobot”) makes no warranties, express or implied. 
Please use the Document with the guidance and assistance of professionals trained in 
supporting the Product. 

Acknowledgment of Intellectual Property Rights 

● Hikrobot owns the copyrights and/or patents related to the technology embodied in the 
Products described in this Document, which may include licenses obtained from third 
parties. Any part of the Document, including text, pictures, graphics, etc., belongs to 
Hikrobot. No part of this Document may be excerpted, copied, translated, or modified in 
whole or in part by any means without written permission. 

●  and other Hikrobot’s trademarks and logos are the properties of Hikrobot 
in various jurisdictions. Other trademarks and logos mentioned are the properties of their 
respective owners. 

LEGAL DISCLAIMER 

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THIS MANUAL AND THE 
PRODUCT DESCRIBED, WITH ITS HARDWARE, SOFTWARE AND FIRMWARE, ARE PROVIDED 
"AS IS" AND "WITH ALL FAULTS AND ERRORS". HIKROBOT MAKES NO WARRANTIES, 
EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION, MERCHANTABILITY, 
SATISFACTORY QUALITY, OR FITNESS FOR A PARTICULAR PURPOSE. THE USE OF THE 
PRODUCT BY YOU IS AT YOUR OWN RISK. IN NO EVENT WILL HIKROBOT BE LIABLE TO 
YOU FOR ANY SPECIAL, CONSEQUENTIAL, INCIDENTAL, OR INDIRECT DAMAGES, 
INCLUDING, AMONG OTHERS, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS 
INTERRUPTION, OR LOSS OF DATA, CORRUPTION OF SYSTEMS, OR LOSS OF 
DOCUMENTATION, WHETHER BASED ON BREACH OF CONTRACT, TORT (INCLUDING 
NEGLIGENCE), PRODUCT LIABILITY, OR OTHERWISE, IN CONNECTION WITH THE USE OF 
THE PRODUCT, EVEN IF HIKROBOT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES OR LOSS. 
YOU ACKNOWLEDGE THAT THE NATURE OF INTERNET PROVIDES FOR INHERENT 
SECURITY RISKS, AND HIKROBOT SHALL NOT TAKE ANY RESPONSIBILITIES FOR 
ABNORMAL OPERATION, PRIVACY LEAKAGE OR OTHER DAMAGES RESULTING FROM 
CYBER-ATTACK, HACKER ATTACK, VIRUS INFECTION, OR OTHER INTERNET SECURITY 
RISKS; HOWEVER, HIKROBOT WILL PROVIDE TIMELY TECHNICAL SUPPORT IF REQUIRED. 
YOU AGREE TO USE THIS PRODUCT IN COMPLIANCE WITH ALL APPLICABLE LAWS, AND 
YOU ARE SOLELY RESPONSIBLE FOR ENSURING THAT YOUR USE CONFORMS TO THE 
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APPLICABLE LAW. ESPECIALLY, YOU ARE RESPONSIBLE, FOR USING THIS PRODUCT IN A 
MANNER THAT DOES NOT INFRINGE ON THE RIGHTS OF THIRD PARTIES, INCLUDING 
WITHOUT LIMITATION, RIGHTS OF PUBLICITY, INTELLECTUAL PROPERTY RIGHTS, OR 
DATA PROTECTION AND OTHER PRIVACY RIGHTS. YOU SHALL NOT USE THIS PRODUCT 
FOR ANY PROHIBITED END-USES, INCLUDING THE DEVELOPMENT OR PRODUCTION OF 
WEAPONS OF MASS DESTRUCTION, THE DEVELOPMENT OR PRODUCTION OF CHEMICAL 
OR BIOLOGICAL WEAPONS, ANY ACTIVITIES IN THE CONTEXT RELATED TO ANY NUCLEAR 
EXPLOSIVE OR UNSAFE NUCLEAR FUEL-CYCLE, OR IN SUPPORT OF HUMAN RIGHTS 
ABUSES. 
THE PERFORMANCE DATA IN THIS PUBLICATION IS BASED ON HIKROBOT’S INTERNAL 
RESEARCH/EVALUATION. ACTUAL DATA MAY VARY DEPENDING ON SPECIFIC 
CONFIGURATIONS AND OPERATING CONDITIONS AND HIKROBOT SHALL NOT BEAR THE 
CONSEQUENCES ARISING THEREFROM. 
IN THE EVENT OF ANY CONFLICTS BETWEEN THIS MANUAL AND THE APPLICABLE LAW, 
THE LATTER PREVAILS. 
 

Symbol Conventions 
The symbols that may be found in this document are defined as follows. 
 

Symbol Description 

Danger 
Indicates a hazardous situation which, if not avoided, will or 
could result in death or serious injury. 

Caution 
Indicates a potentially hazardous situation which, if not avoided, 
could result in equipment damage, data loss, performance 
degradation, or unexpected results. 

Note 
Provides additional information to emphasize or supplement 
important points of the main text. 

  

Available Model 
This manual is applicable to the vision sensors including SC1000 Series, SC2000 Series, 
and SC3000 Series, and smart cameras including SC5000X Series and SC6000 Series. 
This manual is mainly intended for operation of industrial protocols supported by the 
Smart Cameras, including Ethernet/IP, Modbus, PROFINET, KV, MELSEC/SLMP and FINS. 

Contact Information 
Hangzhou Hikrobot Co., Ltd. 
E-mail: global.support@hikrobotics.com 
Website: https://en.hikrobotics.com/ 

mailto:global.support@hikrobotics.com
https://en.hikrobotics.com/
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Chapter 1 EtherNet/IP 

EtherNet/IP is a network suitable for industrial environment and time-critical applications. 
EtherNet/IP uses standard EtherNet, TCP/IP technology and CIP’s open application layer 
protocol, and it can share the network with normal EtherNet communication. 

Note 

● Here we take Omron NX series PLC as an example to explain how to communicate with 
the smart camera via the EtherNet/IP communication protocol. For other devices, refer to 
the user manual provided by the manufacturer and make related settings by reading 
contents of this chapter. 

● For SC5000X series and SC6000 series smart cameras, you can scan the QR code below 
to view details about data communication with PLC via EtherNet/IP. 

 

Figure 1-1 Communication Protocol for Vision Master 4.4.30 
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1.1 Hardware Wiring 

The wiring of Omron NX series PLC and the smart camera is shown below. 

Omron NX Series PLC
Industrial Switch

Smart Camera

...

 

Figure 1-2 Hardware Wiring 

1.2 Smart Camera Settings 

Before using the smart camera’s EtherNet/IP function to communicate with PLC devices, 
you need to set the smart camera first via the SCMVS client software. 
Before you start: 
● Make sure that the PC has installed the SCMVS client software. 

● Check the device’s firmware version. Please refer to the relevant instructions in the 
industrial protocol for specific requirements. 

Note 

Regarding SC5000X series and SC6000 series smart cameras, you need to operate it via the 
embedded VM software, and operations are similar to those via the SCMVS client software. 
 

Steps  

1. Log in the device via the SCMVS client software. 
2. Click Communication on the menu bar. 
3. Click  to add EtherNet/IP communication. 
4. Switch on  to enable EtherNet/IP communication. 
5. Set Input Size and Output Size according to actual demands. 
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Note 

The default value of Input Size and Output Size is 200. 
 

6. (Optional) Enable Result Byte Swap according to actual demands. 

 

Figure 1-3 Set Communication Parameters 

7. Click Scheme Settings in the scheme management pane of the main window, then select 
trigger source in the project editing dialog box according to the actual situation. 

● When using industrial protocol to trigger the device, select Software as the trigger source 
and click the Loop Run in the upper right area of the image live view pane. 

● When using IO to trigger the device, select IO as the trigger source. 
8. Create a project and set parameters for cameras, base images, and vision tools according 

to actual demands. 
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Figure 1-4 Line Existence 

Note 

Here we take the tool of line existence as an example. 
 

9. Go to Output > Tool Results > Add to set the outputted content. 

 

Figure 1-5 Set Tool Results 

Note 

Here we take the module status and module status string of line existence as an example 
to introduce tool results.  
 

10. Save the project. 
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11. If you want to switch projects via communications, go to project management, select 
Trigger Communication as Mode, enter Communication String, and Switch Return String 
according to actual demands. 

 

Figure 1-6 Project Switch Settings 

1.3 PLC Settings 

This section takes Omron NX series PLC as an example to explain how to set PLC. For the 
PLC from other manufacturers or different models, refer to this section and its user manual 
to configure. 

1.3.1 Create Sysmac Studio Project 

You need to create Sysmac Studio project first when using Omron NX series PLC. 

Steps  

1. Run Sysmac Studio, click New Project, enter parameters, and click Create. 



Smart Camera Industrial Protocol Operation Manual 

6 

 

Figure 1-7 Create New Project 

2. Create a new Global Variables whose size should be the same with that of the smart 
camera configured in the SCMVS. 

 

Figure 1-8 Create Global Variables 

Note 

When connecting multiple smart cameras, you should create several global variables with 
different names.  
 

3. Go to Controller Setup → Memory Settings, check Enable of DM, and allocate the global 
variables created in step 2 to DM memory. 
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Figure 1-9 Enable DM Area Type 

4. Go to Controller Setup → Built-in EtherNet/IP Port Settings, and set the IP address of 
PLC port 1. 

 

Figure 1-10 Set IP Address 

Note 

Make sure that the PLC and the smart camera’s IP address are in the same network segment. 
 

5. Click Tools in the menu, and select EtherNet/IP Connection Settings. 
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Figure 1-11 Open EtherNet/IP Connection Settings 

6. Double-click port 1 in EtherNet/IP Device List, and click Registration All in tag sets to 
register global variables. 

 

Figure 1-12 EtherNet/IP Device List 

 

Figure 1-13 Register Global Variables 

7. Right-click in the Target Device area, click Display EDS Library, select the corresponding 
EDS file in the EDS library, and click Install.  
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Figure 1-14 Install EDS File 

8. Click  in the Target Device area to add devices, enter Node address, Model name, and 
Revision according to actual demands, and click Add. 

9. Click  in Built-in EtherNet/IP Port Settings, add created target devices, select 

Consume Data From/Produce Data To as Connection I/O Type, and set size and originator 
variable that are global variable created before. 

 

Figure 1-15 Create Target Device 

10. Go to Tools → Export Global Variables → Network Configurator…, and export the 
global variables. 
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Figure 1-16 Export Global Variable File 

11. Save and compile the project, and synchronize it to the PLC controller. 

 

Figure 1-17 Synchronize to the PLC Controller 

1.3.2 Network Configurator Settings 

After the project is created, you need to set it via the network configurator. 

Steps  

1. Run Network Configurator, click EDS File and select Install…to import the device’s EDS 
file. 
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Figure 1-18 Import EDS File 

2. Drag in the corresponding PLC controller and the smart camera. 
3. Right-click the smart camera to modify its IP address. 

 

Figure 1-19 Modify IP Address 

4. Double-click the PLC, go to Tag Sets → To/From File → Import from File, and import 
the global variables created in the Sysmac Studio. 
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Figure 1-20 Import Global Variables 

5. Establish the connection between the smart camera’s input/output and the global 
variables of PLC controller. Data In connects to Input_13, and Data Out connects to 
Output_22, and set Packet Interval as 50 ms.  

 

Figure 1-21 Establish Connection 

6. Select interface for PLC controller and download configuration to the PLC. 

Note 

After the PLC and the smart camera is successfully connected, the PLC’s red NET ERR 
indicator will go off. 
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Figure 1-22 Select PLC’s Communication Interface Type 

 

Figure 1-23 Connect to the PLC 

 

Figure 1-24 Download Configuration to the PLC 
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1.4 Input and Output Mapping 

1.4.1 Input Mapping 

The definition of input mapping (i.e. smart camera > PLC controller) is shown below. 

Table 1-1 Input Mapping Table 

Byte BIT7 BIT6 BIT5 BIT4 BIT3 BIT2 BIT1 BIT0 

0-1 useful data length 

2     Decoding Acquiring Trigger  

Ack 

Trigger 
Ready 

3     Command 
failed 

Command 
success 

Results 
Timeout 

Results 
Available 

4-17 Reserved 

18-19 Result Length 

20 Result Data 0 

… … 

199 Result Data 179 

… Result Data … 

Table 1-2 Input Mapping Table Description 

Name Description 

Trigger Ready The device is ready to receive new trigger signals.  

When the Trigger Enable is set and the device is ready to 
receive the next trigger signal, the Trigger Ready will be set. 

Trigger Ack The device has already received the trigger signal. 

Acquiring The device is acquiring images. 

Decoding The device is recognizing decodes on images. 

Reserved Reserved. 

Results Available The device outputs new results. When the PLC is set to 
Result Ack, the Results Available will be cleared. 

Results Timeout Results are not gotten when the time is out, and internal 
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1.4.2 Output Mapping 

The definition of output mapping (i.e. PLC controller > smart camera) is shown below. 

Table 1-3 Output Mapping Table 

Byte BIT7 BIT6 BIT5 BIT4 BIT3 BIT2 BIT1 BIT0 

0      Results 
Ack 

Trigger  Trigger 
Enable 

1 Clear 

Error 

      Execute 
Command 

2-17 Reserved 

18-19 User Data Length 

20 User Data 0 

… … 

199 User Data 179 

… User Data … 

 
 
 
 
 

timeout is 6 sec. When the PLC is set to Result Ack, the 
Results Timeout will be cleared. 

Command Success Executing communication command succeeded. 

Command Failed Executing communication command failed. This signal 
can be cleared through Clear Error command. 

Result Length It refers to the length of valid data contained in the result 
area. 

Result Data It refers to the reading result of the device in ASCII code 
format of continuous storage. 

● When the result data length is less than the configured 
result module, the remaining data is filled with 0. 

● When the result data length is greater than the 
configured result module, the extra data is cut off. 
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Table 1-4 Output Mapping Table Description 

Name Description 

Trigger Enable The PLC controls the device’s trigger enable function via this 
bit. 

Trigger When following conditions are met, the PLC sets this bit to 
trigger the device to acquire an image and run the algorithm 
once. 

● Trigger Enable is set. 
● The device is not currently acquiring images and running 

algorithms. 
● Trigger Ready is set. 

Results Ack After the PLC reads the trigger result, it sets this bit to notify 
the device, and the device clears Results Available and 
Results Timeout after confirmation. 

Execute Command Execute the command specified in the User Data area once 
on the rising edge. 

Clear Error Clear error status. 

Reserved Reserved. 

User Data Length It refers to the length of valid data contained in the User Data 
area. 

User Data It refers to the data or commands sent to the device. 
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1.5 Trigger Test 

Communication Sequence Diagram 

The communication sequence diagram of PLC and the device is shown below. 

 

Figure 1-25 Communication Sequence Diagram 

The logic of the above sequence diagram is shown below: 
1. PLC sets Trigger Enable signal DataOut[0].0. After the device is ready, set Trigger Ready 

signal DataIn[2].0. 
2. After detecting the device’s Trigger Ready signal, the PLC sends Trigger signal 

DataOut[0].1 and controls the device to operate once. 
3. The device starts to acquire images and runs the algorithm after receiving Trigger signal. 
● If the result of the algorithm tool is outputted correctly, set the Results Available signal 

DataIn[3].0 and put contents of the configuration result into the address starting from 
DataIn [20]. 

● If the result output times out, set the Results Timeout signal DataIn[3].1 and clear the start 
address of DataIn [20]. 

Note 

For tools like character recognition, the result will be outputted only after the character is 
recognized. Otherwise, the result output will time out at this time. If you need to return 
results quickly, you can use the exception output function. 
 

4. After detecting Results Available, the PLC starts to read results from DataIn [20]. 
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5. After reading results is finished, set Results Ack signal DataOut[0].2, and notify the device. 
6. After triggering is finished, reset the PLC first (set Results Ack) and then repeat the steps 

from 1 to 5 above for a new round of triggering. 

Create Variables 

Create variables in accordance with the device’s input/output mapping area, as shown 
below. 

 

Figure 1-26 Create Variables 

Ladder Diagram 

When the PLC triggers the device to run the project, related ladder diagrams are shown 
below. 
● Enable Trigger 

 

Figure 1-27 Enable Trigger 

● Send Trigger Signal 
The trigger signal can be generated by adding an edge signal before Trigger Ready 
according to actual demands. For example, when the PLC detects the photoelectric input 
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signal, it sends a trigger signal once. 

 

Figure 1-28 Send Trigger Signal 

● Clear Trigger Signal 

 

Figure 1-29 Clear Trigger Signal 

● Get Device Results 
When the device feeds back the Results Available signal, it means that result data has been 
updated, and the PLC can read result data to the user’s storage area. After the reading is 
complete, set the Results Ack signal to acknowledge that the device has completed reading 
result data. 

 

Figure 1-30 Get Device Results 

View Results 

Open the variable monitoring window of the Sysmac Studio, and add the created DataIn 
input variable and DataOut output variable. The online value of the variable is the internal 
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input/output value of the device. 

 

Figure 1-31 View Results 

1.6 Project Switching Test 

The related ladder diagram of project switching test is shown below. 
● Send Switching Command 
Write command character to User Data area, and write command character length to User 
Data Length. 

 

Figure 1-32 Send Switching Command 

● Execute Switching Command 
Write a rising edge to the Executive Command bit in the control area to execute a switching 
command once for the project. 

 

Figure 1-33 Execute Switching Command 
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1.7 FTP Image Saving Naming Test 

The smart camera can receive strings from the PLC via industrial protocols and supports 
using the strings for FTP image saving names or triggering branches. This section 
introduces how to use the communication input string to name FTP image saving files. 

Steps  

1. After settings of the smart camera and PLC, set the camera’s Trigger Source as 
Communication Trigger, and configure the Communication String, for example, “trig”. 

2. On the SCMVS client software Communication Settings page, add FTP Communication 
and set the FileName Strategy to “Subscribe”, with the FileName Subscription set to the 
communication input string. 

 

Figure 1-34 FTP Communication 

3. Click the Continuous Run in the upper right area of the image live view pane.  
4. Write the string to the user data area. For example, to name the image saving file as 

“12345678”, you need to enter the complete string as “trig 12345678”, i.e., write the string 
length at output mapping area 18, and sequentially write the complete string starting from 
address 20. 

5. At output mapping area 0.0, first write 1 to enable the smart camera’s trigger function; 
then write 1 at address 1.0 to execute the user data area command. This will trigger the 
camera once and save the image with the filename “12345678 + timestamp”. 
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Chapter 2 PROFINET 

PROFINET is an open industrial EtherNet standard launched by PI for automation. PROFINET 
uses TCP/IP and IT standards. It is a real-time EtherNet that not only supports standard 
TCP/IP, but also provides time precision that standard EtherNet cannot achieve. 

Note 

● Here we take Siemens S7 series PLC as an example to explain how to communicate with 
smart cameras via PROFINET communication protocol. For other devices, refer to the 
user manual provided by the manufacturer and make related settings by reading contents 
of this chapter. 

● For SC5000X series and SC6000 series smart cameras, you can scan the QR code below 
to view details about data communication with PLC via PROFINET. 

 

Figure 2-1 Communication Protocol for Vision Master 4.4.30 
 



Smart Camera Industrial Protocol Operation Manual 

23 

2.1 Hardware Wiring 

The wiring of Siemens S7 series PLC and the smart camera is shown below. 

Omron NX Series PLC Switch

Smart 
Cameras

...

 

Figure 2-2 Hardware Wiring 

Note 

The device IP address configured in the PLC must be in the same network segment as the 
camera IP address in the SCMVS client but not identical, otherwise it may result in 
communication errors. 
 

2.2 Smart Camera Settings 

Before using the smart camera’s PROFINET function to communicate with other devices, 
you need to set the smart camera first via the SCMVS client software. 
Before you start: 
● Make sure that the PC has installed the SCMVS client software. 
● Check the device’s firmware version. Please refer to the relevant instructions in the 

industrial protocol for specific requirements. 

Note 

Regarding SC5000X series and SC6000 series smart camera, you need to operate it via the 
embedded VM, and operations are similar to those via the SCMVS client software. 
 

Steps  

1. Log in the device via the SCMVS client software. 
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2. Click Communication on the menu bar. 
3. Click  to add PROFINET communication. 
4. Switch on  to enable PROFINET communication. 
5. Enter Device Name according to actual demands. 

Note 

Make sure that the device name is unique. 
 

6. Set Result Module according to actual demands. The default value is 64 bytes. 

 

Figure 2-3 Set Communication Parameters 

7. Click Scheme Settings in the scheme management pane of the main window, then select 
trigger source in the project editing dialog box according to the actual situation. 

● When using industrial protocol to trigger the device, select Software as the trigger source 
and click the Loop Run in the upper right area of the image live view pane. 

● When using IO to trigger the device, select IO as the trigger source. 
8. Create a project and set parameters for cameras, base images, and vision tools according 

to actual demands. 
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Figure 2-4 Line Existence 

Note 

Here we take the tool of line existence as an example. 
 

9. Go to Output > Tool Results > Add to set the outputted content. 

 

Figure 2-5 Set Tool Results 

Note 

Here we take the module status and module status string of line existence as an example 
to introduce tool results.  
 

 



Smart Camera Industrial Protocol Operation Manual 

26 

10. Save the project. 
11. If you want to switch projects via communications, go to project management, select 

Trigger Communication as Mode, enter Communication String, and Switch Return String 
according to actual demands. 

 

Figure 2-6 Project Switch Settings 

2.3 PLC Settings 

This section takes Siemens S7 series PLC as an example to explain how to set PLC. For the 
PLC from other manufacturers or different models, refer to this section and its user manual 
to configure. 

Steps  

1. Run TIA Portal, click Create new project, enter parameters, and click Create. 
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Figure 2-7 Create New Project 

2. Go to Options → Manage general station description files (GSD), import the GSDML files 
to TIA Portal, and click Install. 

 

Figure 2-8 Install GSDs 

3. Go to Devices & networks → Hardware category → Other field devices → PROFINET 

IO → Sensors → Hikvision → Machine Vision Systems, find the corresponding device, 
drag or double-click the device to move it onto the network view. 

4. Add the PLC controller and distribute the device to it. 
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Figure 2-9 Select Device 

5. Double-click the device to set its name. 

 

Figure 2-10 Set Device Name 

Note 

The name configured here should be the same with that in the SCMVS. Otherwise, 
communication error may occur. 
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6. Set the subnet that the interface is networked with, and the IP address. 

 

Figure 2-11 Set IP Address 

Note 

The device IP address must be in the same network segment as the camera IP address in 
the SCMVS client but not identical, otherwise it may result in communication errors. 
 

7. Set the device’s IO cycle and other parameters. 

Note 

Increase the value of Accepted update cycles without IO data in Watchdog time if the 
device goes offline. 
 

8. Recompile and load the PLC program. When the PLC is connected to the device, the 
indicators of the PLC and device will be solid green. 
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Figure 2-12 Load PLC Program 

2.4 Device Module Definition 

The device has six configurable modules as shown below: 
● Acquisition Status Module 
● Acquisition Control Module 
● Reads Result 64 Bytes Module 
● User Data 64 Bytes Module 
● Reads Result 128 Bytes Module 
● Reads Result 250 Bytes Module 

Acquisition Status Module 

The acquisition status module sends the information about the current status of the device 
from the device to the PLC. 
● Slot No.: 1 
● Size: 1 byte 
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Table 2-1 Acquisition Status Module Description 

Bit Name Description 

0 Trigger Ready The device is ready to receive new trigger signal.  

When the Trigger Enable is set and the device is ready 
to receive next trigger signal, the Trigger Ready will be 
set. 

1 Trigger Ack The device has already received the trigger signal. 

2 Acquiring The device is acquiring images. 

3 Decoding The device is recognizing decodes on images. 

4 Results 
Available 

The device outputs new results. When the PLC is set 
to Result Ack, the Results Available will be cleared. 

5 Results 
Timeout 

Results are not gotten when the time is out, and 
internal timeout is 6 sec. When the PLC is set to 
Result Ack, the Results Timeout will be cleared. 

6 Command 
Success 

Executing communication command succeeded. 

7 General Fault An internal error occurred, such as a command 
execution error or the PLC sending an incorrect 
command, and this position is set to 1. 

Acquisition Control Module 

The acquisition control module sends images from the PLC to the device. 
● Slot No.: 2 
● Size: 1 byte 
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Table 2-2 Acquisition Control Module Description 

Bit Name Description 

0 Trigger Enable The PLC controls the device’s trigger enable function via 
this bit. 

1 Trigger When following conditions are met, the PLC sets this bit to 
trigger the device to acquire an image and run the 
algorithm once. 

● Trigger Enable is set. 
● The device is not currently acquiring images and running 

algorithms. 
● Trigger Ready is set. 

2 Results Ack After the PLC reads the trigger result, it sets this bit to 
notify the device, and the device clears Results Available 
and Results Timeout after confirmation. 

3 Execute 
Command 

Execute the command specified in the User Data area once 
on the rising edge. 

4-6 Reserved Reserved. 

7 Clear Error Clear error status. 

Reads Result 64 Bytes Module 

The reads result 64 bytes module reads and sends the device’s processing result from the 
device to the PLC. 
● Slot No.: 3, configurable 
● Size: 65 bytes 

Table 2-3 Reads Result 64 Bytes Module Description 

Bit Name Description 

0 Result Length It refers to the length of valid data contained in the Result 
Data area. 

1…64 Result Data It refers to the result output by the device, and its length is 
64 bytes. 
● When the actual result is smaller than 64 bytes, the spare 

bytes will be filled with 0. 
● When the actual result is greater than 64 bytes, the extra 

bytes will be cut off. 

User Data 64 Bytes Module 

The user data 64 bytes module sends user data from the PLC to the device. 
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● Slot No.: 4, configurable  
● Size: 65 bytes 

Table 2-4 User Data 64 Bytes Module Description 

Bit Name Description 

0 User Data Length It refers to the actual length of data contained in the User 
Data area. 

1…64 User Data It refers to the data or commands sent to the device. 

Reads Result 128 Bytes Module 

The reads result 128 bytes module is the result data and is sent to the PLC by the device. 
● Slot No.: 3, configurable  
● Size: 129 bytes 

Table 2-5 Reads Result 128 Bytes Module 

Bit Name Description 

0 Result Length It refers to the length of valid data contained in the Result 
Data area. 

1…128 Result Data It refers to the result output by the device, and its length is 
128 bytes. 
● When the actual result is smaller than 128 bytes, the 

spare bytes will be filled with 0. 
● When the actual result is greater than 128 bytes, the 

extra bytes will be cut off. 

Reads Result 250 Bytes Module 

The reads result 250 bytes module is the result data and is sent to the PLC by the device. 
● Slot No.: 3, 5, 6, 7, configurable  
● Size: 251 bytes 
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Table 2-6 Reads Result 250 Bytes Module 

Bit Name Description 

0 Result Length It refers to the length of valid data contained in the Result 
Data area. 

1…250 Result Data It refers to the result output by the device, and its length is 
250 bytes. 
● When the actual result is smaller than 250 bytes, the 

spare bytes will be filled with 0. 
● When the actual result is greater than 250 bytes, the 

extra bytes will be cut off. 

2.5 Trigger Test 

Communication Sequence Diagram 

The communication sequence diagram of PLC and the device is shown below. 

 

Figure 2-13 Communication Sequence Diagram 

The logic of the above sequence diagram is shown below: 
1. PLC sets Trigger Enable signal Q0.0. After the device is ready, set Trigger Ready signal 

I0.0. 
2. After detecting the device’s Trigger Ready signal, the PLC sends Trigger signal Q0.1 and 

controls the device to operate once. 
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3. The device starts to acquire images and runs the algorithm after receiving Trigger signal. 
● If the result of the algorithm tool is outputted correctly, set the Results Available signal 

I0.4 and put contents of the configuration result into the address starting from QB2. 
● If the result output times out, set the Results Timeout signal I0.5 and clear the start 

address of QB2. 

Note 

For tools like character recognition, the result will be outputted only after the character is 
recognized. Otherwise, the result output will time out at this time. If you need to return 
results quickly, you can use the exception output function. 
 

4. After detecting Results Available, the PLC starts to read results from QB2. 
5. After reading results is finished, set Results Ack signal Q0.2, and notify the device. 
6. After triggering is finished, reset the PLC first (set Results Ack) and then repeat the steps 

from 1 to 5 above for a new round of triggering. 

Create Variables 

Create a new PLC variable according to the address assigned to the device in the device 
configuration, and you can view the current value of each module of the device online. 

 

Figure 2-14 Overview of Address 
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Figure 2-15 Create PLC Variable 

Ladder Diagram 

When the PLC triggers the device to run the project, related ladder diagrams are shown 
below. 
● Enable Trigger 

 

Figure 2-16 Enable Camera 

● Send Trigger Signal 
The trigger signal can be generated by adding an edge signal before Trigger Ready 
according to actual demands. For example, when the PLC detects the photoelectric input 
signal, it sends a trigger signal once. The figure below describes that a trigger signal is 
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outputted every second via the internal system clock. 

 

Figure 2-17 Send Trigger Signal 

● Clear Trigger Signal 

 

Figure 2-18 Clear Trigger Signal 

● Get Device Results 
Create a DB data block to store the reading result, add the result variable as shown below. 
The first byte is the result length, and the result data is stored starting from the second byte. 

 

Figure 2-19 Add Result Data Block 

When the device feeds back the Results Available or Timeout signal, it means that the result 
data has been updated, and the PLC reads the result data to the DB data block. 
After the reading is finished, set the Results Ack signal to acknowledge that the device has 
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finished reading the result data. 

 

Figure 2-20 Get Results 

View Results 

Through the monitoring and option tab, you can monitor the status of the variables of each 
module of the device and view the result output. You can also add trace records of the 
variables via the Trace tab to view the control sequence. 

 

Figure 2-21 View Results 
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2.6 Project Switching Test 

Hardware Configuration 

Add User Data 64 bytes module to the device, and recompile the hardware configuration and 
download it to the PLC. 

 

Figure 2-22 Add User Data Module 

Ladder Diagram 

Create a DB data block to store the reading result, add the command variable as shown 
below. The first byte is the command length, and command character is stored starting from 
the second byte. 

 

Figure 2-23 Add Command Data Block 
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The related ladder diagram of project switching test is shown below. 
● Send Switching Command 
Write "command length + command character" to User Data 64 bytes module. 

 

Figure 2-24 Send Switching Command 

● Execute Switching Command 
Write a rising edge to the Executive Command of the Acquisition Control Module to trigger 
the execution of the command. 

 

Figure 2-25 Execute Switching Command 

 

2.7 FTP Image Saving Naming Test 

The smart camera can receive strings from the PLC via industrial protocols and supports 
using the strings for FTP image saving names or triggering branches. This section 
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introduces how to use the communication input string to name FTP image saving files. 

Steps  

1. After settings of the smart camera and PLC, set the camera’s Trigger Source as 
Communication Trigger, and configure the Communication String, for example, “trig”. 

2. On the SCMVS client software Communication Settings page, add FTP Communication 
and set the FileName Strategy to “Subscribe”, with the FileName Subscription set to the 
communication input string. 

 

Figure 2-26 FTP Communication 

3. Click the Continuous Run in the upper right area of the image live view pane.  
4. Write the string in the command area. For example, to name the image saving file as 

“12345678”, you need to enter the complete string as “trig 12345678”, i.e., write the string 
length at output mapping area 0, and sequentially write the complete string starting from 
address 1. 

5. At control module 0, first write 1 to enable the smart camera’s trigger function; then write 
1 at address 3 to execute the command area. This will trigger the camera once and save 
the image with the filename “12345678 + timestamp”. 
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Chapter 3 Modbus 

Modbus is a request/response protocol whose services are specified by function codes. 
Port 502 is reserved for Modbus communication. It uses standard EtherNet hardware and 
software to exchange I/O data and diagnostic information. 
Modbus protocol has two different implementation methods. Differences between the two 
are shown below. 

Table 3-1 Comparison of Modbus Protocol Implementation Methods 

Modbus protocol adopts the Modbus TCP implementation method. Because the device only 
has one RS-232 communication serial port, which supports point-to-point connections with 
the PC, and cannot support multiple serial communications, while Modbus TCP offers faster 
transmission speeds. 

Note 

Here we take Siemens S7 series PLC as an example to explain how to communicate with 
smart cameras via Modbus communication protocol. For other devices, refer to the user 
manual provided by the manufacturer and make related settings by reading contents of this 
chapter. 
 

Implementation 
Methods 

Modbus TCP Modbus RTU 

Protocol Stack TCP/IP-based (Ethernet) 
Serial Communication-based 
(RS-232/485) 

Standard Modbus Messaging on TCP/IP Modbus over Serial Line 

Port Default Port 502 None (Physical Serial Port) 

Transmission Speed Fast (100 Mbit/s or 1000 Mbit/s) Slow (Typ. ≤ 115.2 kbps) 
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3.1 Hardware Wiring 

The wiring of PLC controller, Modbus TCP test tool, and the smart camera is shown below. 

Modbus TCP Test Tool

PLC Controller

Industrial Switch

Smart Camera

 

Figure 3-1 Hardware Wiring 

3.2 Smart Camera Settings 

Before using the smart camera’s Modbus function to communicate with other devices, you 
need to set the smart camera first via the SCMVS client software. 
Before you start: 
● Make sure that the PC has installed the SCMVS client software. 
● Check the device’s firmware version. Please refer to the relevant instructions in the 

industrial protocol for specific requirements. 

Note 

Regarding SC5000X series and SC6000 series smart camera, you need to operate it via the 
embedded VM, and operations are similar to those via the SCMVS client software. 
 
 

Steps  

1. Log in the device via the SCMVS client software. 
2. Click Communication on the menu bar. 
3. Click  to add Modbus communication. 
4. Switch on  to enable Modbus communication. 
5. Keep the default parameter settings. 
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Figure 3-2 Modbus Communication Settings 

Note 

Result byte swap is only valid for float type results. 
 

6. Click Scheme Settings in the scheme management pane of the main window, then 
select trigger source in the project editing dialog box according to the actual situation. 
● When using industrial protocol to trigger the device, select Software as the trigger source 

and click the Loop Run in the upper right area of the image live view pane. 
● When using IO to trigger the device, select IO as the trigger source. 
7. Create a project and set parameters for cameras, base images, and vision tools according 

to actual demands. 

 

Figure 3-3 Line Existence 
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Note 

Here we take the tool of line existence as an example. 
 

8. Go to Output > Tool Results > Add to set the outputted content. 

 

Figure 3-4 Set Tool Results 

Note 

Here we take the module status and module status string of line existence as an example 
to introduce tool results.  
 

9. Save the project. 
10. If you want to switch projects via communications, go to project management, select 

Trigger Communication as Mode, enter Communication String, and Switch Return String 
according to actual demands. 

 

Figure 3-5 Project Switch Settings 
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3.3 Modbus TCP Test Tool 

The Modbus TCP test tool can be used to test whether the Modbus communication between 
devices is normal. When the device is working in server mode, Modbus Poll test software 
can be used. When the Modbus Poll software works in client mode, it will automatically 
connect to the device. 

Steps  

1. Enter connection setup parameters according to actual demands. 

 

Figure 3-6 Set IP Address and Port 

Note 

The server port is set as 502. 
 

2. Poll and read the holding registers of the device via the 03 command, start reading from 
address offset 0, and set an appropriate number of read registers and polling read interval 
time. 
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Figure 3-7 Set Polling and Reading Holding Register 

3. Alternately write 3 and 5 to the register of offset address 0 in the control area to trigger 
the device to run the project once, and return the project result in the result area. 

 

Figure 3-8 Single-trigger Photo Capture 

3.4 PLC Settings 

This section takes the Modbus TCP settings of Siemens S7 series PLC as an example to 
explain how to set PLC’s Modbus communication. For Modbus devices from other 



Smart Camera Industrial Protocol Operation Manual 

48 

manufacturers or different models, refer to this section and its user manual to configure. 
 

Steps  

1. Run TIA Portal, click Create new project, enter parameters, and click Create. 

 

Figure 3-9 Create New Project 

2. Add the corresponding PLC controller. 

 

Figure 3-10 Add PLC 

3. Set the IP address of the PLC controller. 
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Figure 3-11 Set IP Address 

4. Go to Communication →  Others →  MODBUS TCP, and add two MB_CLIENT 
commands.  

Note 

Two MB_CLIENT commands: One is used to write to register, and the other one is used to 
read register. 
 

 

 

Figure 3-12 Add MB_CLIENT Commands 

5. MB_DATA_PTR points to the pointer of the data register, create a new MV_SC_REG data 
block to store the communication data of the device’s register, and add variables to the 
data block. 
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Figure 3-13 MV_SC_REG Data Block 

6. Create a new MV_SC_TCON data block at the CONNECT pin, and create two TCON_IP_v4 
type variables (MV_MB_Client_Write, MV_MB_Client_Read), and expand variables to 
assign values to them. 

 

Figure 3-14 MV_SC_TCON Data Block 

Note 

The ID value should be different. 
 

7. Repeat steps above to configure other pins. 
8. Compile project and download it to the PLC controller. 

3.5 Device Register Definition 

The device only uses holding registers and is divided into four areas: control, status, result, 
and command. 

Control 

The PLC sends commands via control area and controls the device to acquire image, and 
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run projects. 
The control area controls the device to get images from PLC to the device. 
● Control area location: holding registers, the default offset value is 0, supporting 

customization. 
● Control area size: 1 register (2 bytes) 

Table 3-2 Control Area Definition 

REG/bit Name Description 

REG0.0 Trigger Enable The PLC controls the device’s trigger enable 
function via this bit. 

REG0.1 Trigger When following conditions are met, the PLC sets 
this bit to trigger the device to acquire an image 
and run the algorithm once. 

● Trigger Enable is set. 
● The device is not currently acquiring images 

and running algorithms. 
● Trigger Ready is set. 

REG0.2 Results Ack After the PLC reads the trigger result, it sets this 
bit to notify the device, and the device clears 
Results Available and Results Timeout after 
confirmation. 

REG0.3-7 Reserved Reserved. 

REG0.8 Execute 
Command 

Execute the command specified in the commands 
area once on the rising edge. 

REG0.9-14 Reserved Reserved. 

REG0.15 Clear Error Clear error status. 

Status 

The status area feeds back the device’s current status from the device to PLC. 
● Status area location: holding registers, the default offset value is 1, supporting 

customization. 
● Status area size: 1 register (2 bytes) 



Smart Camera Industrial Protocol Operation Manual 

52 

Table 3-3 Status Area Definition 

REG1/bit Name Description 

REG1.0 Trigger Ready The device is ready to receive new trigger signals.  

When the Trigger Enable is set and the device is ready to 
receive next trigger signal, the Trigger Ready will be set. 

REG 1.1 Trigger Ack The device has already received the trigger signal. 

REG 1.2 Acquiring The device is acquiring images. 

REG 1.3 Decoding The device is recognizing decodes on images. 

REG 1.4-7 Reserved Reserved. 

REG 1.8 Results Available The device outputs new results. When the PLC is set to 
Result Ack, the Results Available will be cleared. 

REG 1.9 Results Timeout Results are not gotten when the time is out, and internal 
timeout is 6 sec. When the PLC is set to Result Ack, the 
Results Timeout will be cleared. 

REG 1.10 Command 
Success 

Executing communication command succeeded. 

REG 1.11 Command Failed Executing communication command failed. 

REG 1.12-14 Reserved Reserved. 

REG 1.15 General Fault A device’s internal fault occurred, and you can clear this 
signal via Clear Error. 

Result 

The result area stores result data from the device to PLC. 
● Result area location: holding registers, the default offset value is 2, supporting 

customization. 
● Result size: 4 to 500 registers (100 by default). 
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Table 3-4 Result Area Definition 

REG/word Name Description 

REG2 Result Length It refers to the length of valid data contained in the 
result area. 

REG3… Result Data It refers to the result output by the device. 
● When result data length is smaller than 

configured result module, the spare bytes will be 
filled with 0. 

● When result data length is greater than 
configured result module, the extra bytes will be 
cut off. 

Command 

The command area stores commands that users send to the device from the PLC. 
● Command area location: holding registers, the default offset value is 500, supporting 

customization. 
● Command area size: 4 to 500 registers to configure (100 by default). 

Table 3-5 Command Area Definition 

REG/word Name Description 

REG500 User Data 
Length 

It refers to the length of valid data contained in 
the command area. 

REG501… User Data It refers to command character. 
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3.6 Trigger Test 

Communication Sequence Diagram 

The communication sequence diagram of PLC and the device is shown below. 

 

Figure 3-15 Communication Sequence Diagram 

The logic of the above sequence diagram is shown below: 
1. PLC sets Trigger Enable signal REG0.0. After the device is ready, set Trigger Ready signal 

REG1.0. 
2. After detecting the device’s Trigger Ready signal, the PLC sends Trigger signal REG0.1 

and controls the device to operate once. 
3. The device starts to acquire images and runs the algorithm after receiving Trigger signal. 
● If the result of the algorithm tool is outputted correctly, set the Results Available signal 

REG1.8 and put contents of the configuration result into the address starting from REG2. 
● If the result output times out, set the Results Timeout signal REG1.9 and clear the start 

address of REG2. 

Note 

For tools like character recognition, the result will be outputted only after the character is 
recognized. Otherwise, the result output will time out at this time. If you need to return 
results quickly, you can use the exception output function. 
 

4. After detecting Results Available, the PLC starts to read results from REG2. 
5. After reading results is finished, set Results Ack signal REG0.2, and notify the device. 
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6. After triggering is finished, reset the PLC first (set Results Ack) and then repeat the steps 
from 1 to 5 above for a new round of triggering. 

Create Variables 

Create variables in accordance with the device’s register. 

 

Figure 3-16 Create Variables 

Ladder Diagram 

When the PLC triggers the device to run the project, related ladder diagrams are shown 
below. 
● Send Control and Reading Status 
Write MW100 to the control area of the device, read the status area of the device to MW102, 
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and create variables for each bit of control and status. 

 

Figure 3-17 Send Control and Reading Status 

● Enable Trigger 

 

Figure 3-18 Enable Trigger 

● Send Trigger Signal 
The trigger signal can be generated by adding an edge signal before Trigger Ready 
according to actual demands. For example, when the PLC detects the photoelectric input 
signal, it sends a trigger signal once. The figure below describes that a trigger signal is 
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outputted every second via the internal system clock. 

 

Figure 3-19 Send Trigger Signal 

● Clear Trigger Signal 

 

Figure 3-20 Clear Trigger Signal 

● Get Device Results 
Create a DB data block to store the reading result, add the result array variable as shown 
below. 

 

Figure 3-21 Add Result Array Variable 

When the device feeds back the Results Available or Timeout signal, it means that the result 
data has been updated, and the PLC reads the result data to the DB data block. 
After the reading is finished, set the Results Ack signal to acknowledge that the device has 
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finished reading the result data. 

 

Figure 3-22 Get Device Results 

View Results 

Through the monitoring and option tab, you can monitor the status of the variables of each 
module of the device and view the result output. You can also add trace records of the 
variables via the Trace tab to view the control sequence. 

 

Figure 3-23 View Results 

3.7 Project Switching Test 

Create a DB data block to store command data, add the command variable as shown below. 
The first byte is the command length, and command character is stored starting from the 
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second byte. 

 

Figure 3-24 Add Command Data Block 

Note 

The byte order of command character should be set according to the figure above. 
 

The related ladder diagram of project switching test is shown below. 
● Send Switching Command 
Write "command length + command character" to the command area. 

 

Figure 3-25 Send Switching Command 

● Execute Switching Command 
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Write a rising edge to the Executive Command bit in the control area to execute a switching 
command once for the project. 

 

Figure 3-26 Execute Switching Command 

3.7 FTP Image Saving Naming Test 

The smart camera can receive strings from the PLC via industrial protocols and supports 
using the strings for FTP image saving names or triggering branches. This section 
introduces how to use the communication input string to name FTP image saving files. 

Steps  

1. After settings of the smart camera and PLC, set the camera’s Trigger Source as 
Communication Trigger, and configure the Communication String, for example, “trig”. 

2. On the SCMVS client software Communication Settings page, add FTP Communication 
and set the FileName Strategy to “Subscribe”, with the FileName Subscription set to the 
communication input string. 

 

Figure 3-27 FTP Communication 

3. Click the Continuous Run in the upper right area of the image live view pane.  
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4. Write the string in the command area. For example, to name the image saving file as 
“12345678”, you need to enter the complete string as “trig 12345678”, i.e., write the string 
length at REG500, and sequentially write the complete string starting from REG501. 

5. At REG0.0, first write 1 to enable the smart camera’s trigger function; then write 1 at 
REG0.8 to execute the command area. This will trigger the camera once and save the 
image with the filename “12345678 + timestamp”.  
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Chapter 4 KV 

KV (Keyence Visual) communication protocol is a command/response system for industrial 
automation control networks developed by Keyence, and it helps achieve seamless 
communication between various networks. 

Note 

Here we take Keyence KV series PLC as an example to explain how to communicate with 
the smart camera via the KV communication protocol. For other devices, refer to the user 
manual provided by the manufacturer and make related settings by reading contents of this 
chapter. 
 

4.1 Hardware Wiring 

KV Series PLC Industrial Switch

Smart Camera

...

 

Figure 4-1 Hardware Wiring 

4.2 Smart Camera Settings 

Before using the smart camera’s KV function to communicate with other devices, you need 
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to set the smart camera first via the SCMVS client software. 
Before you start: 
● Make sure that the PC has installed the SCMVS client software. 
● Check the device’s firmware version. Please refer to the relevant instructions in the 

industrial protocol for specific requirements. 

Note 

Regarding SC5000X series and SC6000 series smart camera, you need to operate it via the 
embedded VM, and operations are similar to those via the SCMVS client software. 
 

Steps  

1. Log in the device via the SCMVS client software. Click Communication on the menu bar. 
2. Click  to add KV communication. 
3. Switch on  to enable KV communication. 
4. Set the following parameters in the Basic Information Configuration area. 

−Communication Mode: Default is Client. The smart camera serves as the client to initiate 
access. 
−Server IP: Input the PLC’ IP address. 
−Server Port: Use the default value. It must match the port number in the PLC settings in 
the subsequent section. 
−Polling Interval (ms): Set the waiting time after a control command is issued. For 
example, after modifying a control command and triggering a snapshot, the smart camera 
will capture the image only after the polling interval has elapsed. 

Note 

Currently, other modes are not supported. 
 

5. When the device operates in KV Client mode, it is divided into four areas: Control, Status, 
Result, and Command. All areas are located in the data register. The device address and 
number of points can be configured. 

 

Figure 4-2 KV Communication Settings 
−Data Type: Default is 16-bit decimal. Currently, other types are not supported. 
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−Soft Element Type: Default is D. Currently, other types are not supported. 
−Soft Element Address: It must be consistent with the configuration in the PLC control 
software. The address here determines the starting address and size in the PLC control 
software. 
− Soft Element Size: Indicates the minimum space required for this section. The 
example above shows that at least 1 byte is required.  
In the example above, the device address is 0, indicating that the control area must start 
from the 0th register. 

6. Click Scheme Settings in the scheme management pane of the main window, then 
select trigger source in the Project Editing Dialog Box according to the actual situation. 
−When using industrial protocol to trigger the device, select Software as the trigger 
source and click the Loop Run in the upper right area of the image live view pane. 
−When using IO to trigger the device, select IO as the trigger source. 

7. Create a project and set parameters for cameras, base images, and vision tools according 
to actual demands. 

 

Figure 4-3 Line Existence 

Note 

Here we take the tool of line existence as an example. 
 

8. Go to Output > Tool Results > Add to set the outputted content. 
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Figure 4-4 Set Tool Results 

Note 

Here we take the module status and module status string of line existence as an example 
to introduce tool results.  
 

9. Save the project. 
10. If you want to switch projects via communications, go to project management, select 

Trigger Communication as Mode, enter Communication String, and Switch Return String 
according to actual demands. 

 

Figure 4-5 Project Switch Settings 

4.3 PLC Settings 

This section takes the Keyence KV-7500 PLC as an example to explain how to set PLC’s KV 
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communication. For PLC devices from different models, refer to this section and its user 
manual to configure. 

Steps  

1. Run the PLC control software (KV STUDIO Ver.11G_Trial), and select File > New Project 
from the navigation bar. 

2. In the New Project dialog box, enter the Project Name and Location (local storage path 
of the project), select the default supported model KV-7500, and click OK. 

3. In the Confirm Unit Configuration Settings dialog box, click Yes. 
4. On the Settings Unit tab of the Unit Editor page, enter the PLC’s IP address in the IP 

Address parameter field, and use the default value for the Port Number (Upper Link) 
parameter. 

Note 

The IP Address should not duplicate the IP address of the smart camera. 
The parameter value of the Port Number (Upper Link) should match the setting on the 
device side. 
 

 

Figure 4-6 Unit Editor 

5. Click Apply first, then click OK. 
6. In the top navigation bar, click (PLC Transfer > Monitor Mode) to transfer the 

configuration to the PLC. 
In the top toolbar, the connection method must be set to USB, as shown below. 

 

Figure 4-7 Connection Method 

7. In the Transfer Program dialog box, click Execute and wait for the writing to complete. 
8. Configure the registers. 

1) In the software navigation bar, click  to enter the Batch Change/Read Device 

Values window. 
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2) Select Add Device > Batch Insert to run the Batch Insert dialog box and configure the 
following parameters. 

 

Figure 4-8 Add Device 

•Select Device: Choose DM (Data Memory). 
•Starting Number: Must be consistent with the device address configured for each area 

on the smart camera side. For example, if adding register locations for the control 
area (starting from the 1st) as shown in the figure above, then the corresponding 
device address configured on the camera side would be 0. 

•Number of Points: Set the number of registers for each area according to the actual 
required bit length. For example, setting it to 1 means storing 1 unit starting from the 
first address. 

•Display Format: 16-bit hexadecimal is sufficient. You can choose other formats if you 
have specific requirements. 

3) Modify the data in the registers by changing the device values to achieve 
communication with the camera. 

Result 
After the configuration is complete, the Batch Change/Read Device Values Window is 
shown below. 
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Figure 4-9 Batch Change/Read Device Values Window 

4.4 Device Register Definition 

The device only uses holding registers and is divided into four areas: control, status, result, 
and command. 

Control 

The control area controls the device to get images from PLC. 
● Control area location: holding registers, the default offset value is 0, supporting 

customization. 
● Control area size: 1 register (2 bytes) 

Table 4-1 Control Area Definition 

REG/bit Name Description 

REG0.0 Trigger Enable The PLC controls the device’s trigger enable 
function via this bit. 

REG0.1 Trigger When following conditions are met, the PLC sets 
this bit to trigger the device to acquire an image 
and run the algorithm once. 

● Trigger Enable is set. 
● The device is not currently acquiring images 

and running algorithms. 
● Trigger Ready is set. 

REG0.2 Results Ack After the PLC reads the trigger result, it sets this 
bit to notify the device, and the device clears 
Results Available and Results Timeout after 
confirmation. 

REG0.3-7 Reserved Reserved. 

REG0.8 Execute 
Command 

Execute the command specified in the commands 
area once on the rising edge. 

REG0.9-14 Reserved Reserved. 

REG0.15 Clear Error Clear error status. 

Status 

The status area feeds back the device’s current status from the device to PLC. 
● Status area location: holding registers, the default offset value is 1, supporting 
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customization. 
● Status area size: 1 register (2 bytes) 

Table 4-2 Status Area Definition 

REG1/bit Name Description 

REG1.0 Trigger Ready The device is ready to receive new trigger signals.  

When the Trigger Enable is set and the device is ready to 
receive next trigger signal, the Trigger Ready will be set. 

REG 1.1 Trigger Ack The device has already received the trigger signal. 

REG 1.2 Acquiring The device is acquiring images. 

REG 1.3 Decoding The device is recognizing decodes on images. 

REG 1.4-7 Reserved Reserved. 

REG 1.8 Results Available The device outputs new results. When the PLC is set to 
Result Ack, the Results Available will be cleared. 

REG 1.9 Results Timeout Results are not gotten when the time is out, and internal 
timeout is 6 sec. When the PLC is set to Result Ack, the 
Results Timeout will be cleared. 

REG 1.10 Command 
Success 

Executing communication command succeeded. 

REG 1.11 Command Failed Executing communication command failed. 

REG 1.12-14 Reserved Reserved. 

REG 1.15 General Fault A device’s internal fault occurred, and you can clear this 
signal via Clear Error. 

Result 

The result area stores result data from the device to PLC. 
● Result area location: holding registers, the default offset value is 2, supporting 

customization. 
● Result size: 4 to 500 registers (100 by default). 
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Table 4-3 Result Area Definition 

REG/word Name Description 

REG 2 Result Length It refers to the length of valid data contained in the 
result area. 

REG 3… Result Data It refers to the result output by the device. 
● When result data length is smaller than 

configured result module, the spare bytes will be 
filled with 0. 

● When result data length is greater than 
configured result module, the extra bytes will be 
cut off. 

 

Command 

The command area stores commands that users send to the device from the PLC. 
● Command area location: holding registers, the default offset value is 500, supporting 

customization. 
● Command area size: 4 to 500 registers to configure (64 by default). 

Table 4-4 Command Area Definition 

REG/word Name Description 

REG 500 User Data 
Length 

It refers to the length of valid data contained in 
the command area. 

REG 501… User Data It refers to command character. 
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4.5 Trigger Test 

The communication sequence diagram of PLC and the device is shown below. 

 

Figure 4-10 Communication Sequence Diagram 

The logic of the above sequence diagram is shown below: 
1. PLC sets Trigger Enable signal REG0.0. After the device is ready, set Trigger Ready signal 

REG1.0. 
2. After detecting the device’s Trigger Ready signal, the PLC sends Trigger signal REG0.1 

and controls the device to operate once. 
3. The device starts to acquire images and runs the algorithm after receiving Trigger signal. 
● If the result of the algorithm tool is outputted correctly, set the Results Available signal 

REG1.8 and put contents of the configuration result into the address starting from REG2. 
● If the result output times out, set the Results Timeout signal REG1.9 and clear the start 

address of REG2. 

Note 

For tools like character recognition, the result will be outputted only after the character is 
recognized. Otherwise, the result output will time out at this time. If you need to return 
results quickly, you can use the exception output function. 
 

4. After detecting Results Available, the PLC starts to read results from REG2. 
5. After reading results is finished, set Results Ack signal REG0.2, and notify the device. 
6. After triggering is finished, reset the PLC first (set Results Ack) and then repeat the steps 

from 1 to 5 above for a new round of triggering. 
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4.6 Project Switching Test 

Steps  

1. Complete the smart camera and PLC settings, set the switching mode to 
communication switching, and configure the communication string as “switch”. 

2. In the batch change/read window for soft component values, write the switching scheme 
command in the instruction area. Assuming the scheme name is “11111”, the scheme 
switching command is “switch 11111”, which converts to hexadecimal as “73 77 69 74 
63 68 20 31 31 31 31 31”. The instruction is shown in the diagram below. 

Note 

The order of every two characters is from right to left, meaning the low-order byte is on the 
right and the high-order byte is on the left. For characters of “sw”, “7773” should be entered 
in the DM501 soft component. 

 

Figure 4-11 Switching Scheme Command Configuration 

3. In the top menu bar, select PLC > Write All Items to PLC (W). 

4. After writing is completed, click the  (Batch Monitor Window) in the top toolbar to 
verify the write operation. 

5. In the control area, enter “0004”, then select PLC > Write All Items to PLC (W) to clear 
the previous operation. 

 

Figure 4-12 Clear Command 

6. Enter “0100” again, select PLC > Write All Items to PLC (W), and the scheme switching 
will be triggered. 
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4.7 FTP Image Saving Naming Test 

The smart camera can receive strings from the PLC via industrial protocols and supports 
using the strings for FTP image saving names or triggering branches. This section 
introduces how to use the communication input string to name FTP image saving files. 

Steps  

1. After settings of the smart camera and PLC, set the camera’s Trigger Source as 
Communication Trigger, and configure the Communication String, for example, “trig”. 

2. On the SCMVS client software Communication Settings page, add FTP Communication 
and set the FileName Strategy to “Subscribe”, with the FileName Subscription set to the 
communication input string. 

 

Figure 4-13 FTP Communication 

3. Click the Continuous Run in the upper right area of the image live view pane.  
4. Write the string in the command area. For example, to name the image saving file as 

“12345678”, you need to enter the complete string as “trig 12345678”, i.e., write the string 
length at REG500, and sequentially write the complete string starting from REG501. 

5. At REG0.0, first write 1 to enable the smart camera’s trigger function; then write 1 at 
REG0.8 to execute the command area. This will trigger the camera once and save the 
image with the filename “12345678 + timestamp”.  
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Chapter 5 MELSEC/SLMP 

MELSEC/SLMP refers to communication protocols such as reading or writing of the device 
data of the Q/L series programmable controller CPU by external devices via the C24 or E71 
module. 

Note 

● MELSEC/SLMP supports TCP protocol only and does not support UDP protocol. 
● Here we take Mitsubishi O series and FX3U series PLCs as an example to explain how 

to communicate with smart cameras via MELSEC/SLMP communication protocol, 
For other devices, refer to the user manual provided by the manufacturer and make 
related settings by reading contents of chapter. 

5.1 Hardware Wiring 

The wiring of Mitsubishi series PLC and the smart code reader is shown below. 
 

Mitsubishi Q Series PLC

Industrial Switch

Mitsubishi FX3U Series PLC

Smart Camera

...

 

Figure 5-1 Hardware Wiring 

5.2 Smart Camera Settings 

Before using the smart camera’s MELSEC/SLMP function to communicate with other 
devices, you need to set the smart camera first via the SCMVS client software. 
Before you start: 
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● Make sure that the PC has installed the SCMVS client software. 
● Check the device’s firmware version. Please refer to the relevant instructions in the 

industrial protocol for specific requirements. 

Note 

Regarding SC5000X series and SC6000 series smart camera, you need to operate it via the 
embedded VM, and operations are similar to those via the SCMVS client software. 
 

Steps  

1. Log in the device via the SCMVS client software, click Communication on the menu bar. 
2. Click  to add MELSEC/SLMP communication. 
3. Switch on  to enable MELSEC/SLMP communication. 
4. Set the following parameters in the basic information configuration area. 
● Server IP: Input PLC’s IP address. (Required parameter) 
● Server Port: Use the default value. It must match the port number in the PLC settings in 

the subsequent section. (Required parameter) 
● Data Frame Type: Select the data frame type. The default selection is BIN_3E. (Required 

parameter). 
● Network Number: Set the network layer number where the PLC is located. It is used to 

distinguish different network layers. It must match the PLC settings. 
● Node Number: Use the default value. Set the physical address of the PLC in the network 

(similar to MAC address or station number). 
● Processor Number: Use the default value. Set the target CPU module number in the PLC 

(used in multi-CPU systems). 
● Byte Order Enable: Default is disabled. If enabled, byte swapping is applied, and the 

output results will follow the byte order. If disabled, results are output in normal order. 
● Polling Interval (ms): Set the time interval for the smart camera to read PLC register data. 

A smaller value updates data faster with higher real-time performance but increases 
communication load on the network and PLC CPU. A larger value reduces real-time 
performance but lightens the load on the network and PLC. 

● Timeout (ms): Use the default value. Set the maximum waiting time for connecting to the 
PLC. 

5. When the device operates in MELSEC/SLMP mode, it is divided into four areas: control, 
status, result, and command, all located in holding registers. The soft component address 
and soft component points are configurable. 
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Figure 5-2 Melsec/SLMP Communication Settings 

● Address Space: Default is D (other types are currently not supported). 
● Address Offset: Set the offset of each area’s register relative to the starting address. For 

example, 0 means no offset. If set to 1, the command input needs to be offset by 1 
register from the starting position. This must match the configuration in the PLC control 
software, as the starting address in the PLC software is determined by this setting. 

● Data Quantity: Indicates the minimum space required for this section. The diagram above 
shows that at least 1 byte is required. 

6. Click Scheme Settings in the scheme management pane of the main window, then select 
trigger source in the Project Editing dialog box according to the actual situation. 

● When using industrial protocol to trigger the device, select Software as the trigger source 
and click the Loop Run in the upper right area of the image live view pane. 

● When using IO to trigger the device, select IO as the trigger source. 
7. Create a project and set parameters for cameras, base images, and vision tools according 

to actual demands. 
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Figure 5-3 Line Existence 

Note 

Here we take the tool of line existence as an example. 
 

8. Go to Output > Tool Results > Add to set the outputted content. 

 

Figure 5-4 Set Tool Results 

Note 

Here we take the module status and module status string of line existence as an example 
to introduce tool results.  
 

9. Save the project. 
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10. If you want to switch projects via communications, go to project management, select 
Trigger Communication as Mode, enter Communication String, and Switch Return String 
according to actual demands. 

 

Figure 5-5 Project Switch Settings 

5.3 PLC Settings 

This section takes Mitsubishi FX3U series and Q series PLCs as an example to explain how 
to set PLC. For the PLC from other manufacturers or different models, refer to this section 
and its user manual to configure. 

5.3.1 Mitsubishi FX3U Series PLC 

Mitsubishi FX3U series PLC uses an external Ethernet module to realize MELSEC/SLMP 
communication function, and the hardware configuration should be done before use. Use 
FX3U-ENET-L configuration tool to set IP address of Ethernet module and enable MC 
communication function. 

Ethernet Module Configuration 

When using the Mitsubishi FX3U series PLC, the Ethernet module configuration must be 
completed first. 

Steps  

1. Run FX3U-ENET-L configurator, select Module 0, and click Operational settings. 
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Figure 5-6 Ethernet Module Settings 

2. Configure operational settings. 
● Communication Data Code: The device should be set as BIN_1 frame if Binary code is 

selected, and the device should be set as ASCII_1E frame if ASCII code is selected. 
● Initial Time: Select Always wait for OPEN. 
● IP Address: It should be the same with the device’s Server IP address. 

 

Figure 5-7 Ethernet Running Settings 
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3. Click Open settings, select TCP as Protocol, Passive (MC) as Open system, and set 5000 
as Host station Port No. (DEC.). 

 

Figure 5-8 Configure MC Communication Parameters 

4. Write to PLC after configuration. 

Create GX-Works2 Project 

When using Mitsubishi FX3U series PLC, you should also create GX-Works2 project. 

Steps  

1. Create a new GX-Works2 project, set Series and Type in according with FX3U series PLC 

2. Go to Navigation → Connection Destination → PC Side I/F Serial Setting → Serial 
USB, and set COM Port and Transmission Speed. Make sure that PLC can be visited via 
the cable of USB to serial port. 

5.3.2 Mitsubishi Q Series PLC 

Regarding the Mitsubishi Q series PLC, you can configure it via GX-Works2. 

Steps  

1. Create a new GX-Works2 project, set Series and Type in according with Q series PLC. 
2. Click PLC Parameters in the left navigation bar to enter the Parameter Settings dialog. 

Configure the PLC IP Address and Port Number. 
3. Click End Settings > Check > End Setting sequentially to complete the process. 
4. Click Ethernet CC IE/MELSECNET in the navigation bar to configure network-related 

parameters, as shown in the figure below. 

Note 

Configure the IP address as the current network segment of the PLC. 
 

5. Click End Setting > Check > End Setting sequentially to complete the process. 

6. In the navigation bar, click Connection Target, then click Connection1 to enter the 
connection target settings dialog. 
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1) Click Programmable Controller Direct Connection Settings, select Ethernet, choose 
the network adapter of the current PC as the adapter, and enter the current PC’s IP 
address. Click Yes after configuration. 

2) In the Computer Side I/F row, click Ethernet Board, select the network adapter of 
the current PC as the adapter, enter the current PC’s IP address, and click OK after 
configuration. 

3) In the Programmable Controller Side I/F row, click PLC Module, configure as shown 
in the figure below, and click OK after configuration. 

4) In the Other Station Specification row, click No Specification, configure as shown 
in the figure below, and click OK after configuration. 

5) In the Connection Target Settings dialog, click Communication Test. If the PLC is 
successfully connected, a pop-up will indicate a successful connection. 

6) Click OK to save the configuration. 

7. Register Configuration 

7) In the left navigation bar, go to Project > Soft Element Memory, double-click MAIN 
to open the register configuration page, and configure as follows. 

8) Click  to write all device data to the PLC. 

 

Figure 5-9 Writing Soft Elements to PLC  

8. Communication Data Code Setting: When selecting binary code, the device end must be 
configured as BIN_3E frame; when selecting ASCII code, the device end must be 
configured as ASCII_3E frame. 

9. Check Allow Writing During RUN (FTP and MC Protocol). 

10. Open the settings, enable the MC protocol, configure the TCP protocol and port 
number. The port number should match the Server Port configured on the device. 
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5.4 Device Register Definition 

The device is divided into four modules: control, status, result, and command. 

Control 

The control module controls the device to get images from PLC. 
● Control module location: software component D area (the offset is configurable and the 

default value is 0). 
● Module size: 1 word (2 bytes) 

Table 5-1 Control Module Definition 

D0/bit Name Description 

D0.0 Trigger Enable The PLC controls the device’s trigger enable 
function via this bit. 

D0.1 Trigger When following conditions are met, the PLC sets 
this bit to trigger the device to acquire an image 
and run the algorithm once. 

● Trigger Enable is set. 
● The device is not currently acquiring images 

and running algorithms. 
● Trigger Ready is set. 

D0.2 Results Ack After the PLC reads the latest result, this bit will be 
set and the Results OK and Results NG will be 
cleared. 

D0.3 Execute 
Command 

Execute the command specified in the commands 
area. 

D0.4-14 Reserved Reserved. 

D0.15 Clear Error Clear error status. 

Status 

The status module feeds back the device’s current status from the device to PLC. 
● Status module location: software component D area (the offset is configurable and the 

default value is 1). 
● Module size: 1 word (2 bytes) 
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Table 5-2 Status Module Definition 

D1/bit Name Description 

D1.0 Trigger Ready The device is ready to receive new trigger signals.  

When the Trigger Enable is set and the device is ready to 
receive next trigger signal, the Trigger Ready will be set. 

D1.1 Trigger Ack The device has already received the trigger signal. 

D1.2 Acquiring The device is acquiring images. 

D1.3 Decoding The device is recognizing decodes on images. 

D1.4-7 Reserved Reserved. 

D1.8 Results OK The device outputs new results. When the PLC is set to 
Result Ack, the Results Available will be cleared. 

D1.9 Results NG When the device fails to read a code or obtain an output 
result, this bit will be cleared after the PLC sets the 
Results Ack bit. 

Note: When using the NG signal, the NoRead function 
must be disabled. 

D1.10 Command 
Success 

Executing communication command succeeded. 

D1.11 Command Failed Executing communication command failed. 

D1.12-14 Reserved Reserved. 

D1.15 General Fault A device’s internal fault occurred, and you can clear this 
signal via Clear Error. 

Result 

The result module stores result data from the device to PLC. 
● Result module location: software component D area (the offset is configurable and the 

default value is 2). 
● Result size: 2 to 500 words (100 by default). 
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Table 5-3 Result Area Definition 

Word Name Description 

D2 Result Length It refers to the length of valid data contained in the 
result area. 

D3… Result Data It refers to the result output by the device, 128 
bytes in total. 
● When result data length is smaller than 

configured result module, the spare bytes will be 
filled with 0. 

● When result data length is greater than 
configured result module, the extra bytes will be 
cut off. 

Command 

The command area stores commands that users send to the device from the PLC. 
● Command area location: holding registers, the default offset value is 500, supporting 

customization. 
● Command area size: 4 to 500 registers to configure (64 by default). 

Table 5-4 Command Area Definition 

REG/word Name Description 

D500 User Data 
Length 

It refers to the length of valid data contained in 
the command area. 

D501… User Data It refers to command character. 
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5.5 Trigger Test 

The communication sequence diagram of PLC and the device is shown below. 

 

Figure 5-10 Communication Sequence Diagram 

The logic of the above sequence diagram is shown below: 
1. PLC sets Trigger Enable signal D0.0. After the device is ready, set Trigger Ready signal 

D1.0. 
2. After detecting the device’s Trigger Ready signal, the PLC sends Trigger signal D0.1 and 

controls the device to operate once. 
3. The device starts to acquire images and runs the algorithm after receiving Trigger signal. 
● If the result of the algorithm tool is outputted correctly, set the Results Available signal 

D1.8 and put contents of the configuration result into the address starting from D2. 
● If the result output times out, set the Results Timeout signal D1.9 and clear the start 

address of D2. 

Note 

For tools like character recognition, the result will be outputted only after the character is 
recognized. Otherwise, the result output will time out at this time. If you need to return 
results quickly, you can use the exception output function. 
 

4. After detecting Results Available, the PLC starts to read results from D2. 
5. After reading results is finished, set Results Ack signal D2, and notify the device. 
6. After triggering is finished, reset the PLC first (set Results Ack) and then repeat the steps 

from 1 to 5 above for a new round of triggering. 
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5.6 Project Switching Test 

The related ladder diagram of project switching test is shown below. 
● Send Switching Command 
Write command character to User Data area, and write command character length to User 
Data Length. 

 

Figure 5-11 Send Switching Command 

● Execute Switching Command 
Write a rising edge to the Executive Command bit in the control area to execute a switching 
command once for the project. 

 

Figure 5-12 Execute Switching Command 

Steps  

1. Complete the smart camera and PLC settings, set the Switching Mode to 
Communication Switching, and configure the Communication String as “switch”. 

2. In the batch change/read window for soft element values, write the switching scheme 
command in the instruction area. Assuming the scheme name is “11111”, the scheme 
switching command is “switch 11111”, which converts to hexadecimal as “73 77 69 74 
63 68 20 31 31 31 31 31”. The instruction is shown in the diagram below. 

5.7 FTP Image Saving Naming Test 

The smart camera can receive strings from the PLC via industrial protocols and supports 
using the strings for FTP image saving names or triggering branches. This section 
introduces how to use the communication input string to name FTP image saving files. 

Steps  

1. Complete the smart camera and PLC settings, set the camera’s Trigger Source as 
Communication Trigger, and configure the Communication String, for example, “trig”. 
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2. On the SCMVS client software Communication Settings page, add FTP Communication 
and set the File naming policy to “Subscribe”, with the File Naming Subscription set to 
the communication input string. 

 

Figure 4-14 FTP Communication 

3. Click the Continuous Run in the upper right area of the image live view pane.  
4. Write the string in the command area. For example, to name the image saving file as 

“12345678”, you need to enter the complete string as “trig 12345678”, i.e., write the string 
length at D500, and sequentially write the complete string starting from D501. 

5. At D0.0, first write 1 to enable the smart camera’s trigger function; then write 1 atD0.3 to 
execute the command area. This will trigger the camera once and save the image with the 
filename “12345678 + timestamp”.  
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Chapter 6 FINS 

FINS (Factory Interface Network Service) communication protocol is a command/response 
system for industrial automation control networks developed by Omron, and it helps achieve 
seamless communication between various networks. 

Note 

Here we take Omron NX series PLC as an example to explain how to communicate with the 
smart camera via the FINS communication protocol. For other devices, refer to the user 
manual provided by the manufacturer and make related settings by reading contents of this 
chapter. 
 

6.1 Hardware Wiring 

The wiring of Mitsubishi series PLC and the smart code reader is shown below. 

Omron NX Series PLC
Industrial Switch

Smart Camera

...

 

Figure 6-1 Networking Method 

6.2 Smart Camera Settings 

Before using the smart camera’s FINS function to communicate with other devices, you 
need to set the smart camera first via the SCMVS client software. 
Before you start: 
● Make sure that the PC has installed the SCMVS client software. 
● Check the device’s firmware version. Please refer to the relevant instructions in the 
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industrial protocol for specific requirements. 

Note 

Regarding SC5000X series and SC6000 series smart camera, you need to operate it via the 
embedded VM, and operations are similar to those via the SCMVS client software. 
 

Steps  

1. Log in the device via the SCMVS client software.  
2. Click Communication on the menu bar open the Communication Settings dialog. 
3. Click  to add FINS communication. 
4. Switch on  to enable FINS communication and configure relevant parameters. 

−Configure Basic Information 
● Server IP: Enter PLC’s IP address (required). 
● Server Port: Enter PLC's port No. (required). 
● Byte Swap: When enabled, results are output by byte order. When disabled, results are 

output by normal sequence. 
● Timeout (s): Set the timeout duration for connecting to the PLC. 
● Polling Interval (ms): Set the interval for the device to periodically request basic 

information from the PLC. 
−Control, Status, Result, Command configuration 
The parameters in these four areas are similar. Configure them based on the actual 

interface display as follows: 
● Address Space: Set the storage space for instructions. Currently, only DM is supported. 
● Address Offset: Set the address offset for the control area. The default value is 0 (no 

offset). If set to 4, instructions will be offset by 4 registers from the starting position. 
● Data Quantity (Word): Set the number of valid data bits for input. For example, if set to 

1, only 1 bit of data is valid. Inputs exceeding this limit will not take effect. 
● Polling Interval (ms): Set the interval for the device to periodically request control 

instruction data from the PLC. 
● Byte Swap: If enabled, byte swapping is applied, and the output results will follow the 

byte order.  
● Timeout (s): Set the maximum waiting time for receiving results. 

5. Click Scheme Settings in the Scheme Editing pane of the main window, then select 
External Trigger as the trigger mode, and select trigger source according to the actual 
situation. 
● When using industrial protocol to trigger the device, select Software as the trigger source 

and click the Loop Run in the upper right area of the image live view pane. 
● When using IO to trigger the device, select IO as the trigger source. 
6. Create a project and set parameters for cameras, base images, and vision tools according 

to actual demands. 
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Figure 6-2 Line Existence 

Note 

Here we take the tool of line existence as an example. 
 

7. Go to Output > Tool Results > Add to set the outputted content. 

 

Figure 6-3 Set Tool Results 

Note 

Here we take the module status and module status string of line existence as an example 
to introduce tool results.  
 

9. Save the project. 
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10. If you want to switch projects via communications, go to project management, select 
Trigger Communication as Mode, enter Communication String, and Switch Return String 
according to actual demands. 

 

Figure 6-4 Project Switch Settings 

6.3 PLC Settings 

This section takes Omron NJ102-9000 PLC as an example to explain how to set PLC. For 
the PLC from other manufacturers or different models, refer to this section and its user 
manual to configure. 

Steps  

1. Run Sysmac Studio, click New Project, define the project name, and choose the 
corresponding type, device, and version from the Device Selection based on the actual 
hardware used. Click Create. 
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Figure 6-5 Create New Project  

2. In the left navigation pane, go to Configuration and Settings > Controller Settings, click 
Built-in EtherNet/IP Port Settings, and configure Port 2 to be on the same subnet as the 
device. Configure Port 1 as shown in the figure below. 

 

Figure 6-6 Built-In EtherNet/IP Port Settings 

3. Click Memory Settings, check DM to enable the DM area type in memory settings. 
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Figure 6-7 Memory Settings  

4. In the left navigation pane, go to Programming > Data, click Global Variables, and create 
the global variables required for communication. The size should match the values set 
in the SCMVS client. 

Note 

Variable names should start with a capital letter. 
When connecting multiple devices, create multiple input and output global variables with 
different names. 
 

 

Figure 6-8 Create Global Variables 

For other variable types, refer to the figure below. 
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Figure 6-9 Other Variables 

5. After adding global variables, click the Monitor tab in the top toolbar. On the Monitor 
Table page, enter the variable name in the Name field to add a monitor table for viewing 
or modifying data stored in different bits of the registers, as shown below. 

Note 

Click Monitor (Table)* at the bottom of the monitor table and select Add Tab to create 
multiple tabs for viewing data from multiple variables. 
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Figure 6-10 Add Monitor Table 

6. After completing the above configurations, click Online > Sync in the top toolbar, and 
then click Transfer to Controller to download the project to the PLC controller. 

 

Figure 6-11 Sync to PLC 
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Wait for the synchronization to complete. The PLC configuration is finished. 

6.4 Device Register Definition 

The device only uses holding registers and is divided into four areas: control, status, result, 
and command. 

Control 

The control area controls the device to get images from PLC. 
● Control area location: holding registers, the default offset value is 0, supporting 

customization. 
● Control area size: 1 register (2 bytes) 

Table 6-1 Control Area Definition 

REG/bit Name Description 

REG0.0 Trigger Enable The PLC controls the device’s trigger enable 
function via this bit. 

REG0.1 Trigger When following conditions are met, the PLC sets 
this bit to trigger the device to acquire an image 
and run the algorithm once. 

● Trigger Enable is set. 
● The device is not currently acquiring images 

and running algorithms. 
● Trigger Ready is set. 

REG0.2 Results Ack After the PLC reads the trigger result, it sets this 
bit to notify the device, and the device clears 
Results Available and Results Timeout after 
confirmation. 

REG0.3-7 Reserved Reserved. 

REG0.8 Execute 
Command 

Execute the command specified in the commands 
area once on the rising edge. 

REG0.9-14 Reserved Reserved. 

REG0.15 Clear Error Clear error status. 

Status 

The status area feeds back the device’s current status from the device to PLC. 
● Status area location: holding registers, the default offset value is 1, supporting 
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customization. 
● Status area size: 1 register (2 bytes) 

Table 6-2 Status Area Definition 

REG1/bit Name Description 

REG1.0 Trigger Ready The device is ready to receive new trigger signals.  

When the Trigger Enable is set and the device is ready to 
receive next trigger signal, the Trigger Ready will be set. 

REG 1.1 Trigger Ack The device has already received the trigger signal. 

REG 1.2 Acquiring The device is acquiring images. 

REG 1.3 Decoding The device is recognizing decodes on images. 

REG 1.4-7 Reserved Reserved. 

REG 1.8 Results Available The device outputs new results. When the PLC is set to 
Result Ack, the Results Available will be cleared. 

REG 1.9 Results Timeout Results are not gotten when the time is out, and internal 
timeout is 6 sec. When the PLC is set to Result Ack, the 
Results Timeout will be cleared. 

REG 1.10 Command 
Success 

Executing communication command succeeded. 

REG 1.11 Command Failed Executing communication command failed. 

REG 1.12-14 Reserved Reserved. 

REG 1.15 General Fault A device’s internal fault occurred, and you can clear this 
signal via Clear Error. 

Result 

The result area stores result data from the device to PLC. 
● Result area location: holding registers, the default offset value is 2, supporting 

customization. 
● Result size: 4 to 500 registers (100 by default). 
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Table 6-3 Result Area Definition 

REG/word Name Description 

REG 2 Result Length It refers to the length of valid data contained in the 
result area. 

REG 3… Result Data It refers to the result output by the device. 
● When result data length is smaller than 

configured result module, the spare bytes will be 
filled with 0. 

● When result data length is greater than 
configured result module, the extra bytes will be 
cut off. 

 

Command 

The command area stores commands that users send to the device from the PLC. 
● Command area location: holding registers, the default offset value is 500, supporting 

customization. 
● Command area size: 4 to 500 registers to configure (100 by default). 

Table 6-4 Command Area Definition 

REG/word Name Description 

REG 500 User Data 
Length 

It refers to the length of valid data contained in 
the command area. 

REG 501… User Data It refers to command character. 
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6.5 Trigger Test 

Communication Sequence Diagram 

The communication sequence diagram of PLC and the device is shown below. 

 

Figure 6-12 Communication Sequence Diagram 

The logic of the above sequence diagram is shown below: 
1. PLC sets Trigger Enable signal D0.0. After the device is ready, set Trigger Ready signal 

D1.0. 
2. After detecting the device’s Trigger Ready signal, the PLC sends Trigger signal REG0.1 

and controls the device to initiate barcode reading. 
3. The device starts to acquire images and decodes after receiving Trigger signal. 
● If the barcode is recognized correctly, set the Results OK signal D1.8 and put the barcode 

length and content into the address starting from D2. 
● If no barcode is recognized, set the Results NG signal D1.9 and clear the start address of 

D2. 

Note 

● With NoRead enabled: If no code is read, reports Results OK + "NoRead" characters. 
● With NoRead disabled: If no code is read, reports Results NG. 
 

4. After detecting Results OK/NG, the PLC starts to read results from D2. 
5. After reading results is finished, set Results Ack signal D0.2, and notify the device. 
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6. After triggering is finished, reset the PLC first (set Results Ack) and then repeat the steps 
from 1 to 5 above for a new round of triggering. 

Note 

If the device cannot output results due to internal errors (e.g., IDMVS connected but image 
acquisition not started), it sets the General Fault signal (D1.15). The PLC should then set the 
Clear Error signal (D0.15) after confirming the error cause. Once cleared, triggering can 
resume. 
 

Create Variables 

Based on the device memory area definitions, create variables as shown below. 

 

Figure 6-13  Create Variables 

Ladder Diagram 

When the PLC continuously triggers barcode reading, relevant ladder diagrams can be 
seen as follows: 
⚫ Enable Device Trigger 

 
Figure 6-14 Enable Device Trigger 

 
⚫ Trigger Barcode Reading 

Add edge signals before Trigger Ready to generate triggers based on application 
needs (e.g., triggered by a photoelectric sensor input). 

 
Figure 6-15 Trigger Barcode Reading 
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⚫ Clear Trigger Signal 

 
Figure 6-16 Clear Trigger Signal 

 
⚫ Retrieve Device Results 

When Results OK or NG is received, the PLC reads result data into the user’s memory 
area.  
After reading, set Results Ack to confirm. 
If the barcode byte order is incorrect, enable byte-swapping for result data in the 
device configuration. 

 
Figure 6-17 Retrieve Device Results 

 
⚫ Clear Errors 

 
Figure 6-18 Clear Errors 

View Results 

Use the monitoring window to check the status of device module variables and view 
output results. 

6.6 Project Switching Test 

Steps  

1. Complete the smart camera and PLC settings, set the switching mode to 
communication switching, and configure the communication string as “switch”. 

2. In the instruction area registers, write the switching scheme command in the instruction 
area. Assuming the scheme name is “null”, the scheme switching command is “switch 
null”, which converts to hexadecimal as “73 77 69 74 63 68 20 6e 75 6c 6c”. The 
instruction is shown in the diagram below. 
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Figure 6-14 Switching Scheme Command Configuration 

3. Write "0x0004" into the Control Area Registers to clear the previous content, then enter 
the trigger command "0x0100". Press Enter after inputting to trigger the scheme 
switch. 

 

Figure 6-15 Trigger Scheme Switch 

6.7 FTP Image Saving Naming Test 

The smart camera can receive strings from the PLC via industrial protocols and supports 
using the strings for FTP image saving names or triggering branches. This section 
introduces how to use the communication input string to name FTP image saving files. 

Steps  

1. After settings of the smart camera and PLC, set the camera’s Trigger Source as 
Communication Trigger, and configure the Communication String, for example, “trig”. 

2. On the SCMVS client software Communication Settings page, add FTP Communication 
and set the FileName Strategy to “Subscribe”, with the FileName Subscription set to the 
communication input string. 

 

Figure 6-16 FTP Communication 

3. Click the Continuous Run in the upper right area of the image live view pane.  
4. Write the string in the command area. For example, to name the image saving file as 

“12345678”, you need to enter the complete string as “trig 12345678”, i.e., write the string 
length at REG500, and sequentially write the complete string starting from REG501. 
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5. At REG0.0, first write 1 to enable the smart camera’s trigger function; then write 1 at 
REG0.8 to execute the command area. This will trigger the camera once and save the 
image with the filename “12345678 + timestamp”. 
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Chapter 7 Revision History 

Table 4-1 Revision History 

Version Document No. Revision Date Revision Details 

V1.1.0 UD45347B Dec. 26, 2025 

⚫ Add descriptions related to KV protocol, 
MELSEC/SLMP, and FINS protocol. 

⚫ Add explanation of Modbus protocol 
implementation methods. 

⚫ Add QR code of communication protocol 
Vision Master 4.4.30 (SC5000X and SC6000 
smart cameras) for details about data 
communication with PLC via EtherNet/IP and 
PROFINET. 

V1.0.2 UD43601B Jun. 27, 2025 Fix some errors. 

V1.0.1 UD42936B May 15, 2025 Fix some errors. 

V1.0.0 UD26475B Sept. 9, 2022 Original version. 
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